
 
 
 
TRAX Pro SP User Guide 
Welcome to ADX TRAX Pro 3 SP! This guide provides an           
in-depth look at the features, functionality and workflow of the          
software. To quickly learn how to use and work with ADX           
TRAX Pro SP, please consult the Quick Start page ​here​. Use           
the ​table of contents to navigate to a specific topic, or proceed            
step-by-step through the document.  
 
Direct any questions or issues you may encounter with the use           
or installation of ADX TRAX Pro SP to:        
support@audionamix.com. 
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Welcome to ADX TRAX Pro SP! 

Introduction 

What is ADX TRAX Pro SP? 
TRAX Pro SP builds on the foundation of the award-winning          
software, ADX TRAX, to offer the first full-feature, automated         
speech separation software. Separate, isolate and remove       
monophonic melodies, vocals, speech and dialogue from full        
mono or stereo mixes. 
 
ADX TRAX Pro SP introduces a speech-optimized separation        
algorithm which automatically detects and separates speech,       
allowing you to extract or remove dialogue from background         
elements. TRAX Pro SP also includes a new automatic         
consonants detection feature to help maintain the clarity of the          
separated voice. We’ve also expanded the lower pitch range         
on separations to improve the performance of the software on          
deeper voices. 
 
The addition of the speech algorithm means more creative         
options, so TRAX Pro SP streamlines the separation workflow         
with new automatic extraction options. Drop in your audio file          
and easily select whether to separate dialogue, melodic        
content like vocals, or both. TRAX Pro SP is simply the most            
comprehensive and powerful separation tool available. 

What can ADX TRAX Pro do? 
ADX TRAX Pro SP can separate speech or any monophonic          
melodic line from a mono or stereo file. The separation          

process yields two files, which sum together to the original          
mix. In the typical use, ADX TRAX Pro SP separates the mix            
into an Extraction file and a Background file. ADX TRAX Pro           
SP supports WAV, AIFF, MP3, M4A, AAC, and CAF formats,          
up to 192kHz, 32 bit. 

Quick overview of ADX TRAX Pro SP 
TRAX Pro SP is composed of three tabs, the Separate tab, the            
Process tab, and the Spectral tab. These tabs contain all the           
tools you need for a start-to-finish workflow. 
 

 
 
Using state of the art audio analysis and separation         
techniques, this revolutionary software will automatically      
create two separated tracks: an Extraction track and a         
Background track. It also provides access to an estimated         
pitch guide line of the targeted speech / melodic content. 
 
Upon completion of the initial separation, you can utilize a set           
of standard editing tools to refine and customize the pitch          
guide line and separate the original file again to create a more            
accurate separation. Once the pitch guide line correctly traces         
your target content, you can then move on to the process           
screen, where an assortment of advanced separation       
algorithms can be applied. TRAX Pro SP even has a familiar           
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comping feature that allows you to quickly select the best parts           
of each separation and export. 
 
ADX TRAX Pro SP adds spectral editing as a finishing step in            
the workflow. The spectral tab offers access to powerful tools          
such as denoise, smart attenuate, and tonal/noisy gain        
reduction. Each edit made on the spectral tab is         
non-destructive, meaning that information is never lost, it        
simply moves between the vocal and music files. 

System Requirements 
Supported Format:  

● Stand-alone 
 
Supported Operating Systems:  

● Mac OS X 10.9, 10.10, 10.11, 10.12 and 10.13 
 
Minimum System Requirements 

● CPU - Core Duo 2.3Ghz 
● RAM - 8 GB 
● Internet connection is required for license activation       

and cloud-based separation processing. 
 
Recommended System Requirements: 

● Mac OS X 10.11 
● CPU - 1.4GHz dual-core Intel Core i5 
● RAM - 8 GB 

Installation 
To install ADX TRAX Pro SP, open the .dmg file and drag the             
TRAX Pro SP icon to the Applications folder.  

 

Authorization 
The first time you open ADX TRAX Pro SP, you will need to             
authorize it. The License Window will appear. 

 
In order to authorize your software, you should have your          
Username and your API Key that you received when you          
purchased TRAX Pro SP. This information can be found on          
your​ ​account​ page. 
 

NOTE: ADX TRAX Pro SP requires an active Internet         
connection for authorization and use. 
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Quick Start 

Creating your first project 
When you first open ADX TRAX Pro SP, choose to create a            
new project from the Quick Start dialog (shortcut ⌘N). 

 
Once your project is created, import a supported audio file by           
dragging and dropping onto the interface, or through the File >           
Import Audio (⌘I) menu command. 
 
Select your Target (what you’re trying to extract) in the          
following settings window and click OK. The Automatic        
Separation will begin. 

 

The Automatic Separation 
The Automatic Separation process consists of uploading       
specific encoded file information, cloud-based separation      
processing, downloading and decoding results. Once      
complete, the original mix is separated into two distinct tracks:          
the vocal (extraction) and the music (backing track). 
 
You can at this point solo, mute, or rebalance the mix between            
these two elements using the Music and Vocal track controls          
on the Separate Screen. 
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If the Automatic Separation missed any areas of the melody          
you are trying to target and isolate, the next step in the            
process is to refine your Pitch Guide. 

Refining your Pitch Guide 
A Pitch Guide indicates visually via the Pitchogram the areas          
of a voice or melody that will be separated during processing.           
A Pitch Guide can be either a line or a selection.The automatic            
pitch guide is the highlighted blue line in the Pitchogram. This           
line traces the fundamental frequency of content that was         
separated during the automatic process. The green selections        
indicate automatically detected consonants. 

 
In order to improve the accuracy of your separation, you can           
use the Edit Tools that are available below the Pitchogram.          
Once you’ve refined your Pitch Guide to accurately trace the          
target speech or melody, run the separation process once         
again by clicking on the Separate button. You can always A/B           
your results to compare your progress and access previous         
results. Your Automatic and Refined separations are also        
accessible from the Separations List. 

Accessing Additional Processing 
When the pitch guide is tracing the voice or melody you're           
trying to extract, then it's time to switch to the ​Process Screen​,            
where you will be able to chose Advanced Algorithm Options          
(including the ability to extract the reverb along with the voice),           
or to go to the ​Spectral Screen​, in order to make Spectral Edits             
and perfect your results. 
 
You can swap between the Separate and the Process screens          
from the tabs at the top of the interface. 
 

 
You can also choose to Bounce the separated elements from          
the File menu. 
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The TRAX Interface 

ADX TRAX Pro SP Main Workspace 
Here is a general overview of ADX TRAX Pro SP main           
workspace. The interface has been designed in order to guide          
you step by step when performing your separation. ADX TRAX          
Pro is composed of three tabs that contain all the tools you            
need for a start-to-finish workflow. 
 

1. Separate, Process and Spectral Screens 
2. Original file and waveform overview 
3. Music and Vocal tracks 
4. Separations List 
5. Timeline ruler and Payhead 
6. Transport controls 
7. Zooming 
8. Master Volume Knob 

 
As opposed to other Digital Audio Workstations, ADX TRAX         
Pro SP hasn't been designed to mix, but to un-mix. It's           
therefore important to understand its unique workflow to        
achieve the best results. 
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Separate, Process and Spectral Screens 
ADX TRAX Pro SP is composed of three screens, the          
Separate screen, the Process screen, and the Spectral        
screen. 
 
The ​Separate Screen allows you to create and refine the pitch           
guide to target the speech, vocal, or melody you would like           
separated from the rest of the mix. It is the first step in the              
ADX TRAX Pro SP workflow. 
 
The ​Process Screen allows you to apply advanced processing         
/ post-processing and to create composite tracks. 
 
The ​Spectral Screen allows you to access spectral editing         
tools to perfect your separation. 
 
You can swap between the Separate, Process and Spectral         
screens from the tabs at the top of the interface (or use the             
⌘= shortcut to swap tabs). 

How do I know when I should change from one          
screen to another?  
Each screen has been created with a particular goal in mind           
and represents a different step in a start-to-finish workflow. It is           
therefore important to understand how each of these steps         
guides you towards achieving your separation. 
 
As soon as your Pitch Guide traces the pitch and the           
consonants you're trying to extract as closely as possible, it's          
time to move forward to the Process Screen. 
 

The Process Screen allows you to run your separation with          
different processing options, make a composite track from the         
results, or apply post-processing options such as the Spatial         
Isolation Tool. 
 
Finally, go to the Spectral Screen, the final step in perfecting           
your results. This screen allows you to visually edit the vocal           
and music tracks, moving audio information between them.        
Doing Spectral Edits can take some time, so the better your           
initial result, the faster you will work on your Spectral Screen.           
Our goal is to simply get you there faster! 

Original File and Waveform Overview 
Displays the ​original filename of     
the imported audio mix at the      
top-left of the interface after import. 
 
 
 
The ​Listen button solos the     
original file at any time for      
comparison and reference.  
 
 

 
The ​waveform overview displays the full duration and        
waveform of the original audio file. The highlighted area         
denotes what is currently displayed in the vocal track, music          
track and Pitchogram. Click and drag on the highlighted area          
to navigate through the file. Use the tabs on either side of the             
highlighted area to adjust horizontal zoom levels in the Music /           
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Voice tracks and Pitchogram. Drag an audio file here to import           
it at the start of a project. 

Separation Tracks 
Accessing the Music track and the Vocal track changes slightly          
depending on stage of your work. 
 
Remember that in ADX TRAX Pro SP, listening to the Vocal           
track and the Music track at the same time always equals the            
Original file. Nothing is lost! At every step, any information          
removed from the Vocal track is immediately added back to          
the Music track, and vice versa. 
 
On the Separate Screen, the Vocal and Music tracks display          
the separated target Vocal waveform, or the separated        
backing track once a separation is performed. Solo, mute,         
volume and pan controls are included.  
 

 

 
 
On the Process Screen and on the 
Spectral Screen, you have to swap 
between Vocal and Music by using 
the tabs. You can also toggle the 

two tabs using the keyboard shortcut (⌘-). 

Separations List 
Displays separations in a project. The Separations list is         
populated first by an automatic separation, then a user-refined         
separation. Once advanced processing and post-processing      

options are applied, the resulting pair of separated files will be           
listed in the Processed Files area. Any rendered spectral edits          

will also appear as processed files.  
 
On the Separate Screen​: 
 
To display a given pair of Music / Vocal         
tracks on the Separate screen (in order       
to remix their levels and pan), click on        
the colored dot next to the desired       
separation in the Separations list. 
 
To display / hide a given separation to        
audition it or to create a composite,       
click on the dots next to the desired        
separations in the Separations list. 
 
On the Process Screen​: 
 
You can display a maximum of four       
tracks at once on the Process      
Screen. Only one separation can     
viewed at the same time on the other        
screens. This is why the Process      
Screen is the perfect place to compare       
the Separations, and to choose the      
best result. Colored dots indicate     
currently visible separations. Grey dots     
indicate hidden separations. 
 
On the Spectral Screen: 
 
You can only display and work on one        
track at the same time on the Spectral        
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Tab. If you want to work on another separation after applying           
some edits, you must first choose whether to discard your          
current edits or render them as a new track. 
 

 
 
You can also delete unwanted files by right-clicking on their          
names in the Separations List. Deleting a processed file         
cannot be undone. 

 

Time ruler and Playhead 
The Time Ruler is a guide for viewing the time at a particular             
point of the audio file. Displayed in minutes : seconds. 
 

 
The Playhead displays the current playback position (in time).         
The Playhead can Return on Stop (N). This functionality is          
accessible from the Options menu. 

Transport controls 
Includes controls to navigate through time. 

 
Return to beginning of the file (↵) 
 

Rewind 
 

Play (spacebar) 
 

Pause (spacebar) 
 

Fast Forward 
 

Jump to end of file 
 

Toggle on / off loop playback (⌘L) 

 
A looped time selection is indicated by a white repeat sign. 
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Zooming 
Zoom Tools are comprised of single zoom tools        
(arrow buttons), a zoom to fit tool (center button),         
and zoom presets (click and hold on disclosure        
triangle). 

 
Single level zoom out horizontally centered around       
current view. 
 
Single level zoom in horizontally centered around current        
view. 
 
Single level zoom in vertically (pitchogram and       
spectrogram only) centered around current view. 
 
Single level zoom out vertically (pitchogram and       
spectrogram only) centered around current view. 

 
You can also zoom using the scroll wheel on your mouse.           
Scroll up to zoom in horizontally, and scroll down to zoom out            
horizontally. To zoom in and out vertically, hold the Option          
modifier. To move the position of your playhead, hold the Shift           
key. 
 
You can also use familiar keyboard shortcuts to zoom         
horizontally: ⌘[ to zoom out, ⌘] to zoom in. 
 
Or add the option modifier to zoom vertically: ⌥⌘[ to zoom out,            
⌥⌘] to zoom in. 
 

Zoom Presets: Click the disclosure triangle to access the new          
zoom to fit feature, or to the preset horizontal zoom values of            
either 5 or 20 seconds. 
 
Zoom to fit is accessible via the center zoom button, the View            
menu, or with the quick command ⌥F. Click and drag on a            
specific area of the pitchogram or spectrogram using this tool          
and it will zoom to fit your selection to your entire screen. 

 
Zoom All Out (⌥A): Zooms out to whole file view (show           
all). 

Master Volume Knob 
Controls and displays the overall     
output level of all audio (in dB). If        
the overall output is clipping, the      
dB indicator will turn red. Click      
on the dB level to clear the red        
clip indicator.  
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The Separate Screen 
The Separate Screen allows you to create and refine the pitch           
guide to target the melody line or the Speech line you would            
like separated from the rest of the mix. It is usually the first             
step in the ADX TRAX workflow, but can also be used to            
create a new level mix between any pair of separated Music           
and Vocal tracks. 

 
The Separate Screen is made of a ​Pitchogram where a ​Pitch           
Guide Line traces over the exact target melody and defines          
what will be separated. Consonants are indicated via green         
time selections. 
 
Refining your Pitch Guide​ is the first step in improving results. 

Importing an Audio File 
You can import a supported audio file by dragging and          
dropping onto the interface, or through the File > Import Audio           

(⌘I) menu command. Once the file is loaded, TRAX will ask           
you to choose some project-specific options. 

 
With the release of TRAX and TRAX Pro SP, we've integrated           
a new Target system, affecting both AVAD and Pitch         
Detection. The accuracy of the Pitch Guide is improved when          
choosing the correct Target, depending on your usage. 
 
‘​Speech and Melodic Vocals​’ uses an advanced algorithm to         
detect where a human voice is present and extract content          
only for these sections. 
 
‘​Speech Only​’ uses an advanced algorithm to detect where a          
human speech is present and extract content only for these          
sections. 
 
‘​Melodic Vocals​’ uses an advanced algorithm to detect        
where a human singing voice is present and extract content          
only for these sections. 
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‘​General​’ turns off the Automatic Voice Activity Detection        
(AVAD). ADX algorithms extract melodic content for the entire         
duration of the file; the Pitch Guide Line covers the entire           
length of the Pitchogram. 
 
NOTE: After this process, use the "Listen" button to listen to           
your original file, and use the Guide Tone to listen to the Pitch             
Guide Line in order to make edits. The Vocal and Music tracks            
become available after the separation process. 
 
NOTE: Because the Automatic Separation process includes       
the Pitch Guide calculation, both options can't be checked at          
the same time. 
 
The ​Automatic Separation process consists of uploading       
specific encoded file information, cloud-based separation      
processing, downloading and decoding results. By default, this        
option is checked and ADX TRAX Pro starts the process after           
import. 
 
The Automatic Consonants Detection algorithm     
automatically identifies and highlights consonants to tailor       
separations and improve audibility of hard-to-distinguish noisy       
consonants and breaths. 

The Pitchogram 
The Pitchogram is a frequency-restricted spectrogram      
representation of the full audio file, scaled to emphasize the          
range of vocal melody (60Hz - 1100Hz). The pitchogram         
displays the relationship between time, frequency (pitch) and        
amplitude (loudness). Time (location in the context of the         
song) is shown across the x-axis and frequency across the          
y-axis. Amplitude is shown by color brightness. The brighter         

the color, the stronger the signal. The Pitchogram allows for          
easy visualization of changes in frequency and amplitude over         
time. 
 
ADX TRAX Pro SP includes a new and improved Pitchogram          
display that is optimized for both melody and speech targeting.          
You should be able to easily visualize your target content and           
highlight the brightest areas in the Pitchogram for separation. 
 

 
 
You can use the Pitchogram Controls in order to personalize          
your Pitchogram: 
 

 
You can change the color scheme, the brightness, and the          
contrast. Option-click on a control to reset it to its default           
value. 
The pitchogram has been designed in order to easily edit the           
Pitch Guide Line. 
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Pitch Guide and Pitch Guide Line 

What is a Pitch Guide? 

 
A Pitch Guide indicates visually via the Pitchogram the areas          
of a vocal melody and of the consonants that will be separated            
during processing. A Pitch Guide can be either a line or a            
selection. Pitch guides can be saved and loaded using the file           
menu. They can also be loaded by dragging and dropping a           
file-compatible .pitch file from the Finder. This makes it easy to           
share your work with collaborators. Each separation has an         
associated Pitch Guide, the guide indicates what was        
separated. 

Importing a MIDI File as a new Pitch Guide 
ADX TRAX also offers the possibility to create a Pitch Guide           
from a MIDI file. At import, MIDI information is converted into           
marquee selections, which are processed as a refined        
separation when you press the Separate button. 

 
To import a MIDI file as a Pitch Guide, click the           
MIDI Import button, or select File/Import a MIDI        
file. 
 

If the MIDI file contains multiple tracks, TRAX will ask you           
which track you want to load. Only one track can be used as             

the Pitch Guide. Keep in mind that the MIDI file should exactly            
match the length and timing of the audio file, so you should            
edit it before loading into TRAX to make sure it is lined up             
correctly. 
 
TIP: If you plan to import a MIDI file to a new project, disabling              
the Automatic Separation from the Preferences Window before        
importing the audio file will save time and allow you to import            
your MIDI file immediately. 

The Pitch Guide Line 
A Pitch Guide Line traces over the exact vocal melody and           
defines what will be separated. When a file is imported, a Pitch            
Guide Line is automatically generated by the software (if         
Automatic Separation or Pitch Guide Preview is checked at         
import). This Guide Line can be refined by the user using the            
pencil, eraser, pitch magnet, or marquee tools. Opacity is         
controlled by using the Guide Opacity slider. 
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Refining the Pitch Guide 

Editing Tools 
Refining your Pitch Guide is the first step to do in order to             
improve results. You can access different refinement tools by         
going in the Tools Menu or by clicking on their respective icons            
under the Pitchogram. You can also access the tools by          
right-clicking anywhere in the ​Pitchogram​, or by their        
associated keyboard shortcuts. 
 

 
 

1 The Pencil Tool - The pencil allows you to draw a            
freehand ​Pitch Guide Line​. Click and drag in the         
pitchogram to trace and identify the target melody to         

be separated. Hold the Control key to get an auditory preview           
of your cursor location. Hold the Shift modifier to lock the pitch            
position of the pencil, to assist with highlighting the same note           
multiple times. 

 
2 The Pitch Magnet - Creates assisted pitch guide         
selections. Hover your cursor over a melody and the         
pitch magnet will smartly estimate and highlight the        

melody in green. 
 
Click and drag to trace and identify the target melody to be            
separated. All of your edits are shown in red in the pitchogram. 
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3 The Marquee Tool - Use the Marquee tool to          
designate a pitch guide area, a highlighted       
time/frequency range on the pitchogram that contains       

material to be separated. The marquee tool is especially useful          
to greatly improve separation results quickly. It is also good          
when the specific melody line is difficult to see in the           
pitchogram, as it can be used to highlight the general area. 

 
4 The Consonants Tool - Use the Consonants tool to          
indicate where consonants are on a time range on the          
pitchogram. The consonants tools has been created to        

improve consonants extraction. Consonant annotations are      
optional, but help identify and extract sounds such as "ch" or           
"s", which are often missed when annotating the pitch only. A           
Consonant Annotation can be placed over any point on a Pitch           
Guide Line. 
 

 
 

Note: When annotating the Pitch Guide with the Pencil or          
Marquee Tools, hold the "C" key to temporarily select the          
Consonants Tool. 

 
5 The Eraser Tool - Use the eraser to remove areas           
of the pitch guide. Erase any area that you do not want            
identified as vocal and separated. Click and drag to         

erase. 
 
Holding the Option modifier lets you quickly switch from an edit           
tool to the Eraser Tool. Using this key command will erase           
only what the current edit tool is drawing. For example, if you            
are using the Consonants Annotation Tool, holding Option will         
erase only the Consonants Annotations and not the rest of the           
Pitch Guide. 
 

You can hear your changes on the Pitch Guide Line by           
using the ​Guide Tone​. This tool allows you to have a quick            
feedback on your changes, without having to run your         
refinements every seconds.  

Running Refinements 
 
Once you’ve edited the Automatic Pitch      
Guide, click on the Separate button to       
send your edits to the cloud, yielding a        

Refined separation, which can be accessed from the        
Separations list, and is shown in red. 

 
A/B Sliders: The A/B slider allows you to        
compare the current separation result to      
the previous result. B represents the      
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current results and pitch line. A represents the previous result          
and pitch line. Click to toggle and A/B your results. 

The Guide Tone 
The Guide Tone allows the user to listen        
to the Pitch Guide Line using a generated        
tone. Guide controls can be used to solo,        
mute, pan or adjust the volume of the        
tone. Holding the control modifier will also       
temporarily toggle on a guide tone that       
follows the position of the cursor as it        
hovers over the pitchogram. 
 
The ​Guide Tone is very useful when       
refining the Pitch Guide​. It permits to have        
a direct feedback of your Pitch Guide Line        
without having to run a separation. 
 
The ​Guide Opacity slider adjusts the      
opacity of the ​Pitch Guide Line​. Adjusting       

this slider can be useful in visualizing both the pitch guide line            
and the underlying pitchogram information at the same time. 

Creating a New Vocal / Music Mix 
The Separate Screen offers the ability to make a new pan and            
levels mix between the separated vocal and music tracks. To          
do so, select the desired separation from the Separations list          
by clicking on the associated colored dot. Once selected, use          
the Music and Vocal track controls to change the volume of           
the elements. 

 
The Separate Screen displaying the SI Enhancement track 

with a new Music / Vocal balance (vocal down 10 dB). 
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The Process Screen 
The Process Screen allows you to apply advanced processing         
/ post-processing and to create composite tracks. 

 
 
Advanced Processing Algorithms allow you to create       
customizable separations based on your pitch guides       
that take into account unique vocal parameters such        

as reverb and panning. 
 
Post-Processing Tools allow you to target percussive       
elements, specific pan and frequency information from       
previously created separations.  
 
The intuitive ​swipe-to-comp feature allows you to combine the         
best of multiple separations into a single composite track. You          
can display and combine up to four separations and processed          
files at a time. 

Advanced Processing Algorithms 
ADX TRAX offers several additional processing options that        
can customize results to unique mix characteristics and        
increase the quality of your results. To access these options,          
click the Processing icon or head to the Actions menu >           
Advanced Processing Options. 

 
Once you select advanced processing, you will need to         
choose which Pitch Guide to use as the basis for the           
Advanced Processing; either the Automatic guide or the        
Refined guide. If you’ve done any edits / refinements, you’ll          
want to select the Refined guide. 
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The Separation Options menu will then appear. Select any         
combination of these options, with the exception of reverb         
processing (you can only apply short or long, not both). 
 
Consonants Boost - Processes the file with a focus on the           
high frequencies. Use this to have more high frequencies in          
the extracted file. This algorithm impacts the entire length of          
the audio file. In order to extract the consonants only, use the            
consonants tool available from the separate screen. 
 
Short Reverb - Processes the file and includes a short reverb           
tail analysis. The reverb will be separated and included with          
the vocal separation file. 
 

Long Reverb - Processes the file and includes a long reverb           
tail analysis. The reverb will be separated and included with          
the vocal separation file. 
 
High Quality - Processes the file using a different algorithm to           
produce a higher quality separation. Note that this option will          
make the separation process take significantly longer. 
 
Panning Position​: To separate vocals that are panned        
off-center within the stereo field, try adjusting the pan sliders to           
the approximate positional range of the vocal. For centered         
vocals, leave the sliders at their default position. 

 
Once you’ve selected your desired processing options, you’ll        
be able to choose a custom name and color for your advanced            
separation. By default, track colors are set randomly and         
naming conventions follow your selected algorithms.      
Separation names cannot contain special characters (such as        
* or /). If your name contains an invalid character, you will            
receive an error message. Click OK to accept your name and           
color combination and to initiate the processing. 

Post-Processing Tools 
Apply these tools from the Process screen to further improve          
upon already-processed separations. Anything removed from      
the original vocal separation will be added to the music          
separation, therefore improving both files simultaneously. The       
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resulting files are accessible under the Processed Files        
section of the Separations List.  

 
The Drum Enhancement (Music tab) / Drum       
Removal (Vocal tab) tool can be used to        
remove or enhance percussive elements and      
drum hits from the track. To access this tool,         
click the button, then select the track to which         

you want to apply the post-processing from the drop-down         
menu. You can apply post-processing to any track that is          
visible in the Process screen. Once you’ve selected the target          
track the new track dialog box will appear, allowing you to           
name and choose the color of the track. 

 
The Spatial Isolation Tool allows you to refine        
separation results by isolating unwanted audio      
by frequency and pan position. To access this        
tool, click on its associated icon in the toolbar.         
All adjustments will be applied to the currently        

soloed track. You can hear adjustments in real-time with this          
tool.

 

The Spatial Isolation Tool 
The Spatial Isolation Tool allows you to refine separation         
results by isolating unwanted audio by frequency and pan         
position. To access this tool, click on its associated icon in the            
toolbar. All adjustments will be applied to the currently soloed          
track. You can hear adjustments in real-time with this tool. 
 
Frequency Slider: Adjusts the frequency range of the audio to          
be isolated. 
 
Pan Sliders:​ Adjust the pan range of the audio to be isolated. 
 
Ambience Slider: Helps remove sounds that are not in phase.          
Can be useful to get rid of reverb elements. 
 
Tonal/Noise Sliders: Adjust the amount of tonal or noisy         
elements to be extracted. 
 
Smoothness Slider: May reduce artifacts (musical noise), at        
the cost of more interference from other sources. Default         
setting is off (0%). 
 
Key Listen Button: When on, previews the audio being         
extracted and sent to the opposing partner file (to the music if            
on the vocal tab, and vise-versa). 
 
Bypass Button: Bypasses the Spatial Isolation tool to allow         
you to A/B your post-processing to the original results. 
 
Lock Button: Applies the chosen settings and creates a new          
track from the results. Default naming for this track is SI           
Enhancement. 
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How to Apply Spatial Isolation Processing: 
On the Vocal tab: The Spatial Isolation tool will start with the            
frequency and pan sliders all the way out. Use the sliders to            
isolate the audio inside the pan/frequency area and remove         
any leftover music outside it. Turn the key listen button on to            
hear the audio being removed. Turn it off to hear what will be             
kept. Click the lock button to create a new track in the            
separations list. The music you have just removed will be          
added to what is already on the music tab, and the isolated            
voice will remain on the vocal tab. 
 
On the Music tab: The Spatial Isolation tool will start with the            
frequency sliders all the way out, but the pan sliders set to 2L             
and 2R. This allows you to hear the full music mix to start.             
Again, use the sliders to isolate the voice. The difference here           
is that we want to keep the audio outside the pan/frequency           
area. Turn key listen on to hear what will be removed and off             
to hear what will be kept. When you click the lock button, a             
new track will be created. This time, the isolated audio will be            
sent to the vocal tab to be added to the voice, and everything             
else will remain on the music tab. 

Creating a Comp 
The ​Comp Track displays the currently selected composite        
track. To create a comp of your separations, click and drag on            
the desired track to highlight a selection. Hold Shift to add           
more sections on the same track or others. Each selected          
section will be added to the bottom comp track. Whatever is           
contained in the comp track will be exported when you click           
the Export button. To export an individual separation,        
double-click on the track to select the entire track, then click           
the Export button to save it to disk. 
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The Spectral Screen 
The Spectral Screen allows you to access spectral editing         
tools to perfect your separation. After you have completed         
processing your extraction, you will probably notice some        
leftover bleed; bits of music in the vocal track, and pieces of            
vocal in the music track. The Spectral tab allows you to put            
these pieces back where they belong, through the use of a           
detailed spectrogram view and powerful editing tools. Like the         
other functions of ADX TRAX Pro, Spectral tab processing is          
non-destructive. ​Any information removed from the vocal       
track is immediately added back to the music track, and          
vice versa. 

 
The Spectral Screen is comprised mostly of the        
Spectrogram​, but you can access all of your separations from          
the Separations List to the right. On the left are the ​Spectral            
Processing Tools that allow you to directly edit the audio          
information shown in the Spectrogram. To the bottom-left of         

the interface are the controls for the ​Pan-Specific View​, which          
allow you to edit a specific range of the stereo field.  

The Spectrogram 
The spectrogram is a visual representation of the full spectrum          
of frequencies of an audio file over time. The horizontal axis           
represents time, the vertical axis is frequency, and the color          
intensity indicates amplitude. The brighter the color, the louder         
the sound. 

 
 
Located to the lower-left of the Spectral       
screen, the Spectral Settings button offers      
access to advanced controls to customize      
the spectrogram. 
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Spectral Settings 
Accessible from the lower-left of the Spectral Screen or from 
the Setup menu, the Spectral Settings offer advanced controls 
to customize the spectrogram. 

 
Window Size: The drop-down menu lets you choose the size          
of the Fast Fourier Transform (FFT) window, which affects the          
resolution of the spectrogram. The adjustment of this        
parameter is related to a trade-off between a good frequency          
resolution (e.g. for separating two components having       
frequencies close together) and a good time resolution (e.g.         
for a good visualization of frequency modulations over time).         
Larger FFT window sizes will lead to a better frequency          
resolution while decreasing the time resolution. Conversely,       
shorter FFT window sizes will enhance the time resolution         
while decreasing the frequency resolution. 
 
Overlap: Sets the overlap rate between two consecutive FFT         
windows. High values will tend to smooth the time variations of           
the spectrogram.  
 

Scale: Sets the type of frequency scale used to display the           
spectrogram. This affects the frequency resolution. 
 

None: The frequencies of the spectrogram are       
uniformally distributed along the y-axis. The      
spectrogram has a constant resolution along the       
frequency axis. 

Log: The frequencies of the spectrogram are       
logarithmically distributed along the y-axis. This gives       
more importance to the display of lowest frequencies. 

Mel (default): The frequencies of the      
spectrogram are distributed along the y-axis according       
to a Mel scale. This scale reflects the way humans          
perceive pitches and also gives more importance to        
lowest frequencies. 

 
Color Theme: ​Sets the color used to display the spectrogram.          
The spectrogram can either be blue (default) or mandarine. 
 
Contrast: Adjusts the spectrogram magnitude to enhance the        
visualization.  
 
Depth of Undo History: Sets the number of process you'll be           
able to undo. A large depth can make your machine slower.  
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Working with Selections 
Use the Selection Tools to make your spectral selections. The          
wide variety of tools makes it easier to fine-tune your edits.           
You can also access these tools from the Tools menu, and           
through their associated keyboard shortcuts (indicated below).       
Hold the Shift modifier to create multiple selections for         
processing. 
 
Marquee Selector (⌘1)​: Makes simple, rectangular      
selections. 
 

 

Time Selector (⌘2)​: Makes time selections that span the         
entire frequency range. Great for sending entire sections of a          
song to the partner Music / Vocal file. 
 

 
 

Frequency Selector (⌘3)​:   
Selects the entire file for a      
given frequency range.   
Great for removing bass    
bleed from the vocal, to do      
so simply select below the     
fundamental frequency of   
the vocal, then cut the audio      
(⌘X). 
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Lasso Selector (⌘4)​: The lasso tool allows for a freehand          
selection. This is a very flexible and powerful selector. 
 

 
 

Harmonic Selector (⌘5)​: Used to intelligently select multiple        
harmonics from a single selection. To use the harmonic         
selection tool, identify a visible harmonic. 
Then, in the Harmonic Selection Options window, select the         
width, height (frequency range), and which harmonic it is that          
you have your selector on (leave harmonic rank at 0 for the            
fundamental). You can also choose how many harmonics total         
you wish to select. Then simply move the cursor over the           
harmonic and click to automatically select it. Shift-click to add          
to your selection. 
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You can ​invert your selection with the Edit > Spectral Editing           
> Invert Selection (⇧⌘I) menu command. With a time         
selection, the invert command will select all audio outside the          
current selection. With a frequency selection, it will select all          
other frequencies in the same time range. With a Harmonic          
Selection, it inverts the selection in the same time and          
frequency range. 
 

 
 

Go back to your ​previous selection through the Edit >          
Spectral Editing > Previous Selection (⌘U) menu command        
(⇧⌘U to come back).  

Spectral Processing Tools 
Located to the left of the Spectral screen,        
these tools can be used to process your        
spectral selections. You can also access      
these tools from the Actions > Access       
Spectral Processing submenu. You can use      
the shortcut ⌘R to run any of these spectral         
processes. Only one spectral tool can be       

open at once, the open tool dictates the applied processing of           
the ⌘R shortcut. 
 
ADX TRAX Pro SP offers four Spectral Processing Tools: 
    1. ​Gain 
    2. ​Tonal/ Noise Filter 
    3. ​Smart Attenuate 
    4. ​Denoise 
 
In addition to these tools, you can also Cut (⌘X) your           
selection​, which will completely remove the selection from the         
current tab and send it to its complementary track (music or           
vocal). 

Gain 
This slider controls the amount of gain to be added to or            
attenuated from the current selection. The amount of gain         
applied/ reduced is dictated as a percentage of the gain within           
the selection at the time of processing. 
 

 
 

 
25 



Tonal/ Noise Filter 
This tool targets harmonic or noisy components for removal.         
Adjust the sliders to control the % of attenuation. The balance           
slider tells the tool that the selected audio contains more tonal           
or noisy content. 

 
For example, if you want to remove residual string harmonics          
from a breath, you would lower the tonal gain, and shift the            
balance toward the noise side. This tells the feature to remove           
tonal content, but to judge the selection more as noise,          
meaning it will better protect the breath noise from removal. If           
you moved the balance toward the tonal side, you might          
remove too much of the breath. 

Smart Attenuate 
The Smart Attenuate tool uses information to the left and/or 
right of the selection to intelligently attenuate the selection. 

 
For example, a click in the midst of a guitar chord can be             
removed without affecting the sound of the chord. This tool          
consists of three options: Learning size, Centering, and %         
Attenuation. 
 
Learning Size tells the tool how far outside of the selected           
area to look at when determining what will be removed and           
what will not. 
 
Centering will tell the tool to look to the left, right, or            
somewhere in between. 
 
Attenuation determines how much is removed. Information       
that differs from the learning selection will be removed. 

Denoise 
The Denoise tool uses a two-step process to remove         
unwanted audio. First, the tool will learn the spectral profile of           
the audio to be removed. Second, the tool will use this profile            
to remove similar audio from another part of the track. 
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The TRAX Spectral Denoise tool uses the term “complexity” to          
adjust what information (and how much) will be removed.         
Complexity is defined as the variation of spectral contents over          
time. The complexity scale ranges from 1-10, with 1 being the           
most simple signal and 10 being the most complex. 
 
Simple signal​: A steady white noise or a steady tone with no            
vibrato. These signals do not vary over time, so they are           
considered simple. 
 
Complex signal​: A mix with several instruments, drums and         
vocals strongly varies, so it is considered complex. 
 
While this tool can be used to remove standard “noise” from a            
track, its use in TRAX is much more powerful. For example,           
imagine a guitar chord is ringing out as the vocal enters. On            
your vocal track, you hear this guitar bleed into the start of the             
vocal. Using the denoise tool, you can select an area of the            
guitar playing this note without the vocal, press Learn, and          
then apply the tool to the area of vocal that has guitar bleed.             

This will remove the guitar bleed while preserving the vocal          
performance. 
 
Selection Tools​: Use these tools to make your spectral         
selections. The wide-variety of selection tools makes it easier         
to fine-tune your edits to a wide variety of common cleanup           
needs. You can also access these tools from the Tools menu,           
and through their associated keyboard shortcuts (indicated       
below). Hold the Shift modifier to create multiple selections for          
processing. 

Pan-Specific View 
The Pan-Specific View adds another dimension to the        
Spectrogram, that of position within the stereo field. 
 
When the Pan-Specific View is engaged, you no longer see a           
left and a right channel on your spectrogram, you only see the            
selected range within the stereo field, represented by a single          
channel. 

 
All of TRAX Pro's spectral processing and selection tools can          
then be applied with the Pan-Specific View active.  
 
The Pan-Specific section has its own parameters: 

 
On/Off switch: Use this button to      
activate/deactivate the Pan-Specific view. 
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Pan sliders: Use the Left and Right pan indicators to designate           
the range of the stereo field you would like to edit (by default             
the range is between the two indicators). 

 
 
Invert button: Use this button to invert your        
pan range (the areas to the far-left and the         
far-right of the sliders). 
 

Use the Pan Histogram to assist in selecting your pan range.           
The Histogram displays amplitude across the stereo field at         
your playhead position, so it can be very useful in identifying           
panned elements within the mix. When a component, for         
example a guitar, is panned to the right, the peak will be            
displayed on the right of the Histogram display.  
 

 

 
ADX TRAX Pro SP Spectral Tab with Pan Specific View active 

and Mandarine theme. 

Saving your Spectral Edits 
Use the Render button to create a new processed file from           
your spectral edits. The file name defaults to Spectral and is           
available from the separations list after rendered. Separation        
names cannot contain special characters (such as * or /). If           
your name contains an invalid character, you will receive an          
error message.  

 
We advise you to Render your Spectral Edits before quitting          
ADX TRAX Pro to ensure that your edits will be restored           
properly. You also can Render your edits in order to do a new             
balance between the Vocal and the Music tracks from the          
Separate Screen. 
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Finishing Your Work - Exporting Results 
There are several ways to export your results in ADX TRAX           
Pro SP, and you can do so at every stage of your work. 
 
Access the Bounce functionality from the File menu in order to           
export your work at any time.  
 
Bounce Mix to Disk will export what you are currently hearing           
when you hit play (including the Guide Tone on the Separate           
Screen and multiple soloed tracks on the Process screen).         
Note that TRAX PRO SP is non-destructive, meaning that your          
Music and Vocal files will always sum to the original. This is            
true EXCEPT when the Bounce Mix to Disk function is used to            
combine multiple separation tracks from the Process screen. 
 
Bounce Vocal to Disk or ​Bounce Music to Disk will export           
differently depending on your current Screen: 
 
On the Separate Screen: 
Bounces the Vocal or Music isolation from the track that is           
currently selected and in view. 
 
On the Process Screen: 
Bounces the Vocal or Music isolation from your comp track          
(same as Export button). 
 
On the Spectral Screen 
Bounces the Vocal or Music isolation from the current state of           
the Spectrogram (your spectral edits will be taken into         
account, even if they aren’t Rendered). 
 

Bounce All to Disk combines Bounce Mix, Bounce Vocal and          
Bounce Music in one command (yielding 3 separate bounces).  
 
Bounce to STEM​: ADX TRAX Pro SP allows you to export           
your audio files as ​STEMS ​through the File Menu. ​To learn           
more about this new format and its possibilities, consult this          
introduction video. 

Customer Support 
For additional help with ADX TRAX Pro SP, please visit our           
web site at ​www.audionamix.com/support where you will find        
Pro Tips, Tutorials, and Frequently Asked Questions, or        
contact our customer support department at      
support@audionamix.com​. 
 
Our Customer Care team offers significant media industry        
experience, expertise and personal dedication to help you        
resolve technical issues, and stay productive.  
 
Thank you for using ADX TRAX Pro SP. 
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